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Creating custom technical
support Help files

0 you spend a lot of time answering the same questions from users? If so, you've
probably created a FAQ (Frequently Asked Questions) document, like the one
shown in Figure A, and posted it on your network. However, there may be sev-
eral users who can't find the FAQ (or don’t know that it exists) and call you anyway. If
you want to make the information in your FAQ more accessible and its use more intui-
tive, you should consider porting your FAQ over to a Help file.

Most Windows NT users are familiar with Help files and have probably consulted
this handy resource many times, typically to find out how to use features of their favor-
ite applications. In fact, most users rely on this convenient online information—rather
than printed manuals—as their main source of guidance on all aspects of running a PC.
So why not leverage this Help file instinct to your advantage? Contrary to what you
might think, Help files are easy to create. You don’t need any programming skills, and
you don’t have to purchase special software,

In this article, we’ll show you how to create a basic but effective Help file that you
can use to distribute information to your users. We'll finish up by discussing a few
resources that address some of the more advanced Help system features so you can
develop a more involved Help file.

* What's a Meb browser cache?

ach time you vpen a Web page, your browser downluads a copy of the page's text
d graphics and stores it on your hard disk in the browser cache. 1f you access
t:ag:» again, your trowser checks the site’

1f the

your browser retrieves the updated
(|page from the Web site. Although this cache system iz designed to help load Web
pages quicker, your browser will continue to store pages until the
cache is Full. When this happens, your system can rum out of hard disk space.

|* Checking hard disk space in Windows M1 =
Un a Vindows HT sgsten, you can check your hard disk space by apening My Computer,
right-clicking on the drive ¢ icon and selecting the Properties... command ta %
v up the property sheet for your hard disk. The General page of Ihis
properties sheet provides you with a pie chart that shows you how much Free disk _
space you have your hard disk as well as how nuch hard disk space is occupied,
Just above the pie chart is a leqend that indicates in both bytes and negabytes ,
fhow much space on your hard disk is occupied and hou much is free. If you have

1855 than 180 MB of Free space, you'll want to clear the cache.

* Emptying the cache in Internet Explarer 4.0 for Windows NY

To empty Internet Explorer 4.8's cache, pull down the Uiew menu and select the

Internet - connand. Woen the Internet Options properties sheet appears,
Files button in the Tenporary Internet files panel. Once Intprost ¥

Explurer has enptied the cache, clese the Internet Uptions properties sheet. N

Suppose that you've created a FAQ like this one and want to convert it into a Help file.
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What you need

As we mentioned earlier, you don’t
have to buy any special software to
create Help files. All you need are
two pieces of software that you prob-
ably already own or can easily obtain.
They are:

* A word processor capable of
saving files in rich text format
(RTF). Many word processors—
including Microsoft Word,
Corel WordPerfect, and Lotus
Word Pro—meet this require-
ment. (WordPad can save files
in RTF format, but it doesn’t
allow you to insert page breaks
or add hidden text, both of
which are necessary for
creating a Help file.)

* Microsoft's Help Workshop
compiler. Versions of this pro-
gram come with many Win-
dows development tools,
including Microsoft Office 97,
Developer Edition; Microsoft
Visual C++; Microsoft Visual
Basic; and Microsoft Developer’s
Network. If you don’t own one
of these products, you can
download the Help Workshop
compiler in a self-extracting file
(Hewsetup.exe) from Microsoft's
FTP site at ftp.microsoft.com/
softlib/mslfiles /hewsetup.exe,

Figure B

Once you have the necessary soft-
ware, you use the word processor to
type and format the text you want
to distribute. You then use the Help
Workshop compiler to convert your
RTF document into a Help file.

Getting organized

The first step in the process is to or-
ganize your material into topics. A
fopic is the basic unit of information
in a Help file. It contains all the text
you expect to appear in a Help win-
dow at one time. (If a topic is too big
to fit in the window;, the user will be
able to scroll to reach other parts of
it.) One of the most important rules
to keep in mind when creating top-
ics is that you want to limit them to
small, easily digestible chunks of
information. There’s no set limit on
the size of a topic, but it's wise to keep
it under 50 lines of text (assuming
the Help window is about half as
wide as your screen).

Let's suppose that you get a lot of
calls from users who are running
low on hard disk space. This usually
happens when the Web browser’s
cache becomes so full that there’s
no room on the hard disk for saving
documents. To help your users solve
the problem on their own, you've
created the FAQ text file shown in
Figure A, which explains what a

M-wm
Checking hard disk space in Windows
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You use each of the individual topic headings to create the contents topic.



cache is, describes how to check hard disk
space, and shows how to empty the cache.
Now, you'd like to convert the FAQ into a

Help file so that your users can have easy

access to it.

Creating the topics file

Once you've organized your information,
you're ready to enter your topics in a word
processing document and save it using
the RTF format. You can include as many
topics as you like in the document, and
you can place them in any order you want.
(If you have a large number of topics, you
might find it more convenient to spread
them over several document files.)

As you type the topics, you're free to
take advantage of whatever fonts, colors,
and formats your word processor offers.
However, we recommend you keep the
formatting as simple as possible. Your aim
is to convey information, not to impress
the user with fancy visual effects. There-
fore, you should try to limit yourself to
one or two fonts, and be sparing in your
use of colors and text styles.

Now that we've set the guidelines, let's
walk through an example. Suppose you're
using the text in Figure A as your FAQ and
Word 97 as your word processor. You sim-
ply need to copy the text from your FAQ
and paste it into a Word 97 document. You
can then change the font to Arial (or another
font, if you prefer), bold the headings, and
save the document as an RTF file.

Creating the contents topic
The next thing you do is create a contents
topic, which will act as the table of con-
tents for your Help file. (Keep in mind
that the contents topic is different from the
Windows NT Help system contents file—
CNT—even though it performs the same
function.) The contents topic will contain
jumps, or links, to the various topics in
your Help file.

In our example, we’ll use each topic’s
heading to compile the contents topic.

Simply type

What's a Web browser cache?

Checking hard disk space in Windows NT

Emptying the cache in Internet Explorer
4.0 for Windows NT

above the first topic in your document, as
shown in Figure B,
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* What's a Web
Checking hard
Emptying the

e«

cache?
space in Windows NT

in Internet Explorer 4.0 for WindowsNT

What's a Web browser cache?

System can run ot of hard disk spece

Each fimea you open & Web pege. your browser dowrioads 2 copy of the pege's textand g
and storas 1L on your had ciskein the browssr cache If you access the
checks the site's Web server for chenges v the page. If the Web ! 5
hasnt changed since the Jasttime you wsitad the sith, your browear ralnevss a copy of thel
from the cachie If the Wab server repors that the page has changed your browser reeve
updatad page from the Wab site. Although this cache system is designed

auickar, your browses will continus to store pages until the cacho 1 ful Vhen this happeni |

page soMn, your b

0 help |osd Wz

space in Windows NT
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Inserting hard page breaks

At this point, you need to separate each
topic in your topic file with a hard page
break. This code tells the Help Workshop
compiler where one topic ends and the
next one begins. The compiler will ignore
soft page breaks (which the word proces-
sor inserts automatically).

To insert the first hard page break, place
your insertion point marker in front of the
word What’s, pull down the Insert menu,
choose the Break... command, select the
Page Break option, and click OK. Repeat
this process to insert a hard page break
before the words Checking and Emptying,
as shown in Figure C.

Assigning topic IDs
Once you've separated your topics with
hard page breaks, you must assign each
topic a special code, called a topic ID, that
will uniquely identify the topic to the Help
compiler, (You won't assign topic IDs to
the contents topic.) Topic IDs can be up to
255 characters long and can contain any
combination of letters, digits, underscores,
and periods, However, it's best to keep
your topic IDs short—Iless than about 15
characters—and to stick with names or
phrases that will remind you what the
topic contains, For our example, we used
the names Whatls, HardDiskSpace, and
EmptyCache.

To assign a topic 1D, first position the
insertion point marker at the beginning of
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You use hard page breaks to separate each topic In your topic file.
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a topic. Next, using your word processor’s
footnote feature, insert a footnote with a
number sign (#) as the reference symbol,
and then type your chosen topic 1D as the
footnote text.

In addition to assigning a topic 1D, you
should give each topic a title. This step
isn't mandatory, but if you omit the title,
the topic won’t show up in some common
Help file operations, such as when you
define a bookmark, Topic titles can contain
any character, including spaces, in both
uppercase and lowercase, You insert the
topic title in the same way you do the topic
1D, except that you use a dollar sign ($)

Windows NT
Emptying the cache in internet Explorer 4.0 for Windows NT

——— ——— e —— Page oD -
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After we inserted the first topic ID and topic title, our sample document
looks like this.

as the footnote reference symbol. Figure D
shows our sample document after we in-
serted the first topic ID and topic title, You'll
create a topic 1D and topic title for each of
the other two topics in our example.

Creating jumps

Next, you need to provide a method of navi-
gating between your contents topic and the
actual topics. The most common way of
linking topics in a Windows Help file is to
use jump text (also known as a hypertext
link). In our sample document, you'll cre-
ate jumps from each of the headings in the
contents topic to the appropriate topic.

To create the appropriate jump text,
begin by scrolling to the first heading in
your contents topic, What’s a Web browser
cache? Then, apply a double-underline for-
mat to that text. To do so, highlight the
heading, pull down the Format menu,
choose Fonl..., select Double from the
Underline dropdown list, as shown in Fig-
ure E, and click OK. Now, place the inser-
tion point marker immediately to the right
of the heading and type the ID of the topic
you want to jump to (in our case, Whatls).
Finally, format the ID as hidden text by
highlighting it, accessing the Font dialog
box again, and selecting the Hidden check
box in the Effects panel. Check that there’s
no space between the jump text and the ID
and that the ID isn’t double-underlined.

Repeat these steps for each of the headers
in the contents topic. Finally, save the topic
file. Be sure to save it in rich text format.

Figure E Figure F

*What's a Web browser cache?
Each tme yau opan & Wab page, your Drowsor Gownoads & copy of thi Age's 1 ana

You need to use the Double Underline setting
to make the jump work correctly.

4 Windows NT Professional
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When the user clicks on the underined word, cache, a popup topic will appear.



Creating pop-ups

If your Help text contains an unusual tech-
nical term for which you want to supply a
definition, you can use a pop-up. In Help
documents, text formatted in green with
dotted underlining indicates a pop-up.
When the user clicks this type of text, a
window opens and displays a definition,
When the user clicks again, the pop-up win-
dow closes, leaving just the main Help
window onscreen.

You create a pop-up window in the same
way you create a topic, In fact, although
it’s not vbvious to users, a pop-up window
is a topic in its own right. You'll probably
want to enter a pop-up’s text in the same
document as the topic where it will be flag-
ged. To keep the document in manageable
form, you can insert the pop-up text after
the topic it refers to.

To create a pop-up topic, locate the term
you want to flag, scroll to the next topic, and
place your insertion point marker imme-
diately after the hard page break. Then,
type the text you want to appear in the pop-
up window and insert a hard page break
to signify the end of this new topic. Next,
assign a topic ID to the pop-up topic, (You
don’t need to assign a topic title.)

After you've created the pop-up topic,
scroll to the item that you want to link to
your pop-up and format this text with
single underlining, Then, with the inser-
tion point marker immediately to the right
of your underlined text, type the ID of the
pop-up topic and format the ID as hidden
text. Make sure that there’s no space be-
tween the underlined text and the ID and
that the ID isn’t underlined.

For example, in our Help document, the
word cache might be unfamiliar to some
users. To create a pop-up definition for
this term, yvou just type the definition as a
new topic and assign Cache as its topic ID.
Then, you go to the What's a Web browser
cache topic?, underline cache, type the 1D
Cache immediately after it, and format Cache
as hidden text. Figure F shows how your
text should appear at this point.

Setting up the project file

Now that you've created your topics file,
you're ready to create the project file. The
project file is actually a set of instructions
that the compiler uses to create the actual
Help file. You create a project file in Help
Workshop.
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Figure G

You can use the
same filename
for the HPJ file
that you use for
the RTF file.

After you save the HPJ file, Help Workshop will display the project file in
this window.

Figure |

You have to tell Help Workshop where your RTF file Js.

To begin, launch Help Workshop, pull
down the File menu, and select the New...
command. In the resulting dialog box, make
sure that Help Project is selected and click
OK. When the Project File Name dialog box
appears, type the name you want to assign



to the HLP file in the File Name text box, When you click the Save button, Help

using the extension .hpj. For our example, ~Workshop will display the initial project file
we'll use the same filename as the RTF file,  in its window, as shown in Figure H, also ’
as shown in Figure G on page 5. on page 5. At this point, you need to tell

Help Workshop where to find vour RTF file,
To do so, first click the Files... button. Then,
Figure K click the Add... button and in the resulting
[ gl@l|  dialog box, select your RTF file. Once you've
added the RTF file, the Topics Files dialog
box will look like the one shown in Figure 1.
At this point, click OK.

Configuring your Help window
The last thing you do before compiling

your Help file is configure how you want
the Help file’s window to appear. Start by
clicking the Windows... button to open the
Create a Window dialog box. Nexl, type
Mairn in the text box, as shown in Figure |,
and click OK. You'll then see the Window

3 Properties sheet, shown in Figure K. While
gmmsmg& you can configure many aspects of a Help
file's window, for now we'll simply assign
the window a name to use in its title bar
and specify its size. (Once you become
more proficient at creating Help files, you
can experiment with some of the other
window options.)

Type Emptying your Web browser cache in ’
the Title Bar Text box, then click the Position
tab, shown in Figure L. Use the Auto-Sizer
button to specify how large you want your
Help window to be (following the Auto-
Sizer window'’s onscreen instructions).
Finally, click OK to close the Window
Properties sheet.

Compiling the project file
When you return to the project file display,
Figure M click the Save and Compile button. Help

* Help Workshep - {1 | ; Workshop will minimize itself, compile the
project file, and then display a compilation
report, as shown in Figure M.

If your compilation report indicates any
errors, you'll need to resolve them and
recompile the project file. Each error con-
dition is denoted by an error code using the
format hexxay, where xxxx is a number.
For aid in solving your errors, pull down
the Help Workshop's Help menu, select
Help Topics, click the Index tab, type the
error code in the text box, and click Display.
Once you've found a solution, you can
close Help and then return to your word '
processor, make the proper adjustments to
the RTEF file, resave it, return to Help Work-

L] shop, and click the Save and Compile button
This report displays Information about the compilation procedure. to recompile your project file.

BN Windows T Professionai

Simply type Main in the
Create & Window Named
text box.

Use the Auto-Sizer
feature on this tab to
specify the size of
your Help window.
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Testing your Help file

Once your project file compiles success-
fully, you can test your Help file by pull-
ing down the File menu and selecting the
Run WinHelp. .. command. When the View
Help File dialog box appears, select the A
Double-Clicked File Icon option, as shown
in Figure N, and click the View Help button.
You should now see your contents topic
displayed in the Help program’s window,
as shown in Figure O. If you follow the
What's a Web browser cache link and then
click on the underlined word, your screen
will resemble the one shown in Figure P.
When you're satisfied that your Help file
works the way it should, you can close the
test window and then close Help Workshop.

Using your Help file

At this point, you can copy the actual Help
file to a central location and send links to
it to your users. That way, if you ever need
to add information to the Help file, you
have to do so only once, and the changes
will be available to all your users.

Creating more advanced files

The techniques we've shown you in this
article will allow you to create basic, effec-
tive Help files. But with a little practice and
study, you can take what you learn here
and develop more advanced Help files.
A good place to start learning some of the
more advanced Help system features is in
Help Workshop's own Help file. Just pull
down the Help menu, select Help Topics,
and study the information presented on
the Contents tab.

If you prefer printed material, you can
invest in the Microsoft Windows 95 Help
Authoring Kit from Microsoft Press. (Don't
let the title throw you; the same Help sys-
tem that was developed for Windows 95 is
used in Windows NT.) This 336-page book
will provide you with everything you need
to know about creating basic and advanced
Help files. The book sells for $49.95 and
includes a CD that contains the Help Work-
shop compiler. For more information on
the Microsoft Windows 95 Help Authoring
Kit, go to the Microsoft Press Web site
(mspress.microsoft.com/Buy /Search.htm)
and perform a search using the keywords
Help Authoring.

If you're really into creating Help files,
you might want to investigate such power-
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Figure N

View Halp F ik

Selecting the A Double-
Clicked File Ilcon option
and clicking View Help
allows you to easily
test your Help file,
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Make sure you test your pop-up windows,

house programs as Blue Sky Software’s
RoboHELP or Doc-to-Help from WexTech
Systems, You can find out more about
RoboHELP at Blue Sky Software’s Web
site at www.blue-sky.com; for more infor-
mation on Doc-to-Help, visit WexTech'’s
Web site at www.wextech.com.

Conclusion

Most Windows NT users are familiar with
Help files and rely on them heavily to learn
about software. You can leverage this familiar-
ity and create your own Help files to dissemi-
nate information your users need to know. In
this article, we've explained which tools you
need to build Help files, and we've shown
you how to create a sample Help file. ¢
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